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MasterTemplate 16 Release Notes 
 

© Eric Bobrow – August 10, 2012 
 
Welcome to the latest version of MasterTemplate - the Office Standard for ArchiCAD™. The new update 
provides full compatibility with ArchiCAD 16, and also contains new features and revisions based on 
feedback and suggestions from users as well as our own discoveries and innovations. 

This document explains the new features, and outlines strategies for users upgrading from earlier 
versions of MasterTemplate. 
We suggest you read through these Release Notes to see what's new, and then decide how you want to 
transition your own version of AMT. At the end of this document, various approaches will be discussed for 
how to integrate the new version of AMT with your previously customized template. 

Please report anything requiring cleanup in an email to support@actemplate.com. We hope you enjoy 
working with AMT 16. Thanks again for the opportunity to work with you! 
 
Eric Bobrow 
Bobrow Consulting Group 
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Summary of Changes and New Features in MasterTemplate 16 
1) The AMT Legends as well as the Favorites palette elements were revised for compatibility with 

ArchiCAD Library 16. This involved replacing a small number of AC15 parts with their new 
equivalents in AC16. (Most of the existing parts found their corresponding item in the AC16 Library 
without assistance.) In addition, the labels for the Legend elements in the Quick Rooms and Parts 
Matrices were updated to refer to AC16 names.  

2) A new layer was added for Morph elements: Y | SPECIAL | MORPH. This is intended to be used for 
Morph elements "in process". After a Morph is created, it is suggested that the element be placed 
onto a layer consistent with general conventions and usage. For example, if the Morph was created 
from a Stair object, and was modified in terms of detailed geometry, but is still used as a Stair, it 
should go onto the same layer as other Stairs. The Morph layer is visible in most Layer Combinations 
and Views to simplify the workflow.  
 
In general, layer combinations were adjusted and optimized based on user feedback and our 
experience. 

3) A new View pointing to a new work area has been defined for Object Creation, located to the right of 
the Interactive Legends. It is intended that this be used when creating new objects, to store the "raw 
materials" for later reuse. The new Morph tool makes it easier to customize existing library parts or 
imported components for use in a project. Some of these may be turned into new library parts, and 
this work area (and the layer Y | SPECIAL | OBJECT CONSTRUCTION) is the ideal place to store 
the native elements for possible reuse. 

4) The Renovation Filter options were revised to be compatible with the new settings provided by 
Graphisoft in ArchiCAD 16. In particular, this meant that 04 New Construction only shows Existing 
and New elements (not Demo, as in AC15). In AMT15, we had added 06 Show All, which remains in 
the AC16 template but has been modified to use Overrides for Demo and New elements for visual 
clarity. In addition, the Override style for New elements has been adjusted to give a light blue fill so 
that they stand out, with a red tone used for Demo elements. 

5) Views throughout the View Map were reworked to set the Renovation Filter in a more sophisticated 
manner. In AC15, most Views were set to use the 01 Existing Plan filter. In the AC16 template, most 
Plan views are now set to use 04 New Construction, while Elevation, Section, Interior Elevation and 
3D views are set to use 05 Planned Status, and Schedules, Details and Worksheets are generally set 
to 06 Show All. 

6) The Electric Legend was reworked to refer to additional parameters in order to differentiate some of 
the revised parts that may be reconfigured into different symbols and types. To use this as before, to 
display a list of all the Electrical components with their symbols, place the Electric Legend then crop it 
to only show the first three columns - the symbol, the name, and the remarks. The other fields are not 
intended to be displayed, but are only used to distinguish certain parts from each other.  

7) View Settings for the Schedule Clone folder have been reworked to improve the workflow and simplify 
going back and forth between schedules and plan. A new SCHEDULE BASE SHEET View was 
created in the CONSTRUCTION DOCUMENT VIEWS > MISC. VIEWS (NON-CLONE) > MISC. 
PLAN VIEWS folder which uses the CONDOC | M-E-P SYSTEMS layer combination. This View was 
used as the basis for the creation of a new SCHEDULES (CLONE) folder, which was then linked to 
all the schedules placed as drawings on layouts. 

8) The Sample Project file has been updated to use the ArchiCAD 16 Library, and reworked to use the 
new Renovation filters and View settings. In the Sample Project INT the naming conventions for plan 
Views, as well as the scales set for Views and Drawings were updated throughout the project for 
better compatibility with international metric standards. 
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Initial Download and Setup 
 
The AMT download zip files expand into the following files: 
 

• MasterTemplate 16 (USA / INT) TEMPLATE.tpl 
• MasterTemplate Linked Files folder: 

o AMT Layout Master Company Logo.jpg 
o AMT Legends (USA / INT) 16.pln 
o AMT Office Favorites (USA / INT) 16.pln 
o AMT Project Favorites (USA / INT) 16.pln 
o Master Specifications Full Page.doc 
o Master Specifications Full Page.pdf 

• AMT Supplemental Files folder: 
o AMT Work Environment folder 
o Library folders for optional use: 

 AMT16 Embedded Library for USA Version 
 AMT16 Embedded Library for INT Version 

o MasterTemplate NEW PROJECT FOLDER 
o SAMPLE PROJECT (both USA and INT versions) 

• MasterTemplate 16 Release Notes.pdf (this file) 
 
The libraries in the AMT Supplemental Files folder (AMT16 Embedded Library for USA Version and the 
AMT16 Embedded Library for INT Version) do not normally need to be loaded in the Library Manager 
since the contents are embedded into the Legend files. However, for advanced users, these folders are 
provided as an alternative option. 
 
To install AMT 16, download the zip file to your workstation, then unzip to a convenient location into a 
new folder. We recommend placing this into your ArchiCAD Office Standards folder; a good place for this 
is in the Jobs or Projects folder on your hard drive or on the office server. 
 
The AMT 16 file uses three Hotlinked Modules (HLM): one refers to the AMT LEGENDS 16.pln (the main 
“kit of parts”), a second to the AMT Office Favorites 16.pln, and a third to the Project Favorites 16.pln. 
 
When you open up the TEMPLATE you'll get a message saying that these three Hotlinks are missing: 
 

 
 
This is to be expected, since all the files are now on a new workstation, and ArchiCAD doesn’t know 
where to find them. You should ignore this message and continue; you’ll clean it up after you finish 
opening the file. 
 
You will also get a warning about missing PDFs - these are referenced in the Layout Book and used for 
the specifications and general notes pages. As with all previous versions of AMT, it’s simplest to resolve 
this warning message right away by using the Read From… button and choosing the MasterTemplate 16 
Linked Files folder. ArchiCAD will search within that folder, and find the PDF files and relink them. Later, 
when you save the TEMPLATE, all of this will be remembered, so you won't have to deal with them again 
(unless you move the files or decide to change the references). 
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After you finish opening up the TEMPLATE file, go to the Hotlink Manager (File menu > External Content 
> Hotlink Manager) and relink the Hotlink references to the file locations on your hard drive or network. 
Highlight each one of the files in the list, one by one, and use the Relink…from file button, then navigate 
to the MasterTemplate Linked Files folder and select the appropriate file (NOTE: if you can’t “see” any 
files listed inside the MasterTemplate Linked Files folder, change the file type from MOD to PLN using the 
popup menu). Repeat for the other hotlinks, then click OK to proceed with updating the links.
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Changes, Updates and New Features in MasterTemplate 16 
 

1) AMT LEGENDS AND FAVORITES UPDATED FOR ARCHICAD 16 
The AMT Legends were revised for compatibility with ArchiCAD Library 16. Most of the existing 
elements found their corresponding item in the AC16 Library as soon as that library was loaded. 
However, a number of AC15 parts had to be manually swapped out for their new equivalents in the 
AC16 library. The labels for the Legend elements in the Quick Rooms and Parts Matrices were 
updated to refer to AC15 names.  
 
Several new more flexible Electrical objects were substituted for the previous ones in the Objects and 
Lamps Legend. 
The elements in the Favorites palette were also updated as needed for compatibility with ArchiCAD 
16. 

 

2) WELCOMING THE NEW MORPH TOOL 

The Morph tool is a powerful new feature in ArchiCAD 16. It can be used from scratch to quickly and 
interactively create simple or complex forms and shapes that are highly flexible in geometry. In 
addition, existing ArchiCAD elements or groups of elements may be converted into Morphs in order to 
fine-tune or add detail in ways that were never possible before. Finally, the Morph technology may be 
used to rework imported objects (3D DWG, 3DS or SketchUp components), whether generic, custom-
designed or manufacturer-supplied. 

After reviewing the new technology functions and methods, we concluded that MasterTemplate did 
not require significant changes to accommodate the Morph tool. However, we decided to add one 
new layer specifically for Morphs: Y | SPECIAL | MORPH.3D, and integrated this layer into the Layer 
Combinations and Views. 
There appear to three main applications for the Morph technology: 
a) Creating a shape from scratch – building a new element or combination of elements 
b) Converting existing ArchiCAD elements into a Morph in order to rework or add detail 
c) Taking an existing library part or an imported component (3DS, DWG, SKP) and modifying 

it to create a new library part 
We have made the Y | SPECIAL | MORPH.3D layer available as a temporary convenience while 
working on a Morph element. This layer is set to be visible in most of AMT16’s layer combinations. 
After working on the element, in order to integrate the resulting element into the workflow and the 
documentation, move the element(s) to the appropriate layer, similar to other elements of the same 
function. 

For example, you might take a Stair element on the A | FLOOR | STAIRS + LANDINGS + 
ELEVATORS.3D layer and convert it to a Morph in order to change the detailed geometry of the 
steps (e.g. adding a bull-nose edge to the tread) or railing (e.g. extending or changing the shape of 
the railing termination). After you finish working on it, put this new Morph element back on the original 
A | FLOOR | STAIRS + LANDINGS + ELEVATORS.3D layer so that this modified stair will show up 
on the correct Layer Combinations, Views and Drawings. 
Another example: you might place a library part such as a refrigerator and convert it to a Morph, then 
add detail to make it more like the manufacturer model. After finishing revisions, you can put this back 
onto the M | MECHANICAL | EQUIPMENT (APPLIANCES + HVAC).3D layer so that it shows 
properly on the appropriate drawings.  
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3) NEW OBJECT CONSTRUCTION AREA 
In MasterTemplate we have always had a special layer dedicated to construction of library parts: Y | 
SPECIAL | OBJECT CONSTRUCTION.3D. This layer is intended for storing elements used in the 
creation of new objects, keeping them hidden (except in one layer combination (MODEL | OBJECT – 
CONSTRUCTION) but accessible for later reuse or adjustment. 

In AMT16, we introduce a new OBJECT CONSTRUCTION work area, situated to the right of the 
Interactive Legends, as well as a corresponding View in the MODEL / DESIGN VIEWS folder in the 
View Map. You may activate this View to go to this work area, and assemble an object from scratch 
or paste in elements that were already configured in another part of your project model. 

You may leave these elements on their original layers as long as you wish, but in order to hide them 
from normal views (and not be seen when you Fit in Window in Plan or 3D) you should select them 
and use the Edit Selection Set command to move them to the Y | SPECIAL | OBJECT 
CONSTRUCTION.3D layer. 

This work area is ideal for saving your Morph elements that are being turned into library parts. In the 
earlier example of the “morphed” refrigerator, you would drag or cut and paste this completed morph 
refrigerator to the new Object Construction area, save it as a new object to add to the Embedded 
Library or in a folder on your computer, then switch the morph element itself to the Y | SPECIAL | 
OBJECT CONSTRUCTION.3D layer.  

This way, the morph will remain available in the project for additional revisions if necessary (but be 
hidden in most views), while the new object that was just created may be placed into the actual 
project model and be included in appliance schedules properly. 

4) RENOVATION FILTERS REVISED 

When Graphisoft introduced the Renovation technology in ArchiCAD 15, they set up a series of 
Renovation Filters to be used with Views to create various construction drawings. With AMT15, we 
analyzed their efforts, and made some significant changes to these filters to make them more 
effective. 
In ArchiCAD 16, Graphisoft revised the standard Renovation Filters in a number of subtle ways, often 
matching the changes we had made in MasterTemplate (e.g. setting the Override style for Demo 
elements to be Red and Dashed lines). 

After studying the new settings, we decided to base AMT16’s Filters on the revised Graphisoft 
settings for ArchiCAD 16 to reduce technical support questions.  

However, we have made one significant change to their Override settings, and added (as we did 
before) one extra Renovation Filter. 
A notable change in the standard AC16 Renovation Filter settings is that 04 New Construction shows 
Existing and New elements (with the New ones in their Override style) but leaves out the Demo 
elements. In AC15, all three Renovation categories were shown in this 04 New Construction filter. 

For visual clarity, we adjusted the Override Style for New elements to use a light blue for the Fill so 
that these new elements stand out nicely onscreen and in the construction documents, and reworked 
the Override for Demo elements in the INT version to be red (similar to the USA version). 
In AC15, our Renovation Filter called 06 Show All was added to show elements from all Renovation 
categories (existing, demo and new) in their “natural” state (i.e. not with an Override style). In AC16, 
we made this filter show overrides for demo and new categories, so it may be used to create “hybrid” 
construction drawings for simple projects in which a single plan drawing can easily and legibly show 
demo elements and new construction. 
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5) VIEWS REWORKED TO COORDINATE WITH THE RENOVATION FILTERS 
As a follow up to these changes in the Renovation Filters, we went through all the Views in the View 
Map to make sure that the most appropriate Renovation Filter was set either at the Clone Folder 
Settings level or (for Views that were not part of a Clone Folder) in the individual View Settings. 
Our revised strategy for the Renovation Filter settings is to make all Plan drawings (e.g. Floor Plans, 
Ceiling Plans, Structural Plans, etc.) use the 04 New Construction filter, while Sections, Elevations, 
Interior Elevations and other 3D Views are set to 05 Planned Construction. Schedules, Details, 
Worksheets and miscellaneous views were set to 06 Show All. This is a change from AMT15, when 
we set everything to 01 Existing Plan. 

The rationale and workflow is as follows:  
• In a new project that does not involve demolition or new construction, everything should be 

drawn as an Existing element. All Views will work nicely, whether set to 01 Existing Plan (as 
in AMT15), 04 New Construction or 05 Planned Construction, when the model and annotation 
elements are set to “Existing”. 

• In a project involving demolition and new construction, set the elements to the appropriate 
Renovation category.  

o In the Plan views, the 04 New Construction filter will show new elements in the 
Override style with a light blue background. Separate Demolition Plans may be 
created using the appropriate Views in the template, if needed. Optionally, the Plan 
views may be changed to use the 06 Show All filter so that a hybrid drawing is 
produced with all categories color-coded (demo elements in red dashed lines, new 
elements with a light blue background). 

o In Elevation, Section, Interior Elevation and 3D Views, the 05 Planned Construction 
filter is active, allowing you to create drawings showing the end result of the 
construction process.  

o It is anticipated that in most cases this is the best way to communicate the remodel 
process: showing demo information as needed on the plans, but simplifying the “3d 
views” to show only the final design. Exceptions may be made by the user by 
modifying or adding Views with different Renovation Filters. 

 
• TIP: For a guide to how to approach renovation and remodel projects with MasterTemplate 

16, please see the Suggested Renovation Project Workflow section below. 

 
6) ELECTRICAL SCHEDULE / LEGEND UPDATES 

In ArchiCAD 16, a number of the Basic Electrical Items in the object library were made more flexible, 
allowing a single part to be reconfigured to appear in a variety of ways. While this allows more 
variations of these symbols to be placed, it also complicates the process of creating a schedule (a 
tabular list with quantities) or legend (a list with images of the symbols, with or without quantities). 

The Electric Legend in the Schedules was reworked to refer to additional parameters in order to 
differentiate some of the revised parts that may be reconfigured into different symbols and types. To 
use this as before (to display a list of all the Electrical components with their symbols), place the 
Electric Legend then crop it to only show the first three columns - the symbol, the name, and the 
remarks. The other fields are not intended to be displayed, but are only used to distinguish certain 
parts from each other.  

This solution is only a partial one, as Graphisoft has not coordinated the parameters that differentiate 
parts. For example, in one case, the internal variable that determines the variety of component is 
called “itemType”, in another case it is “fanType”, in yet a third it is “switchType”. In addition, there are 
parameters that allow supplemental text to be added to the symbol, such as a “3” to indicate a 3-pole 
switch. These are excellent additions to the library parts in that they are “smarter” and more flexible, 
however there is no uniform, well-defined way to get a coherent list of electrical parts. 
Experimentation may be required to ensure that the schedule shows exactly what you need. 
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7) VIEW SETTINGS FOR SCHEDULES REWORKED 

View Settings for the Schedule Clone folder have been reworked to simplify going back and forth 
between schedules and plan. The issue in previous versions of MasterTemplate came up when a 
user activated a Schedule from the clone folder, then went back to the plan window without activating 
a pre-defined View. This may occur in a variety of workflows:  

• using the keyboard shortcut F2 
• clicking on the plan window to bring it to the front, or  
• using the icon button in the schedule to highlight and zoom to the element(s) selected in the 

schedule 

In MasterTemplate before this version, the settings for the schedule views referred to the layer 
combination * SHOW & UNLOCK ALL LAYERS. Upon returning to the plan, this became problematic 
as many elements were often overlaid and the plan was hard to read. 

Individual views in a clone folder for schedules cannot be revised to use different Layer 
Combinations, as this option is greyed out in the View Settings dialog. The only way to control the 
layers used for the schedules is to activate the desired layer combination before creating the 
Schedule Clone folder, and it affects all schedules. 

Upon analysis, the MEP layer combination was chosen as the best option, allowing the user to see 
most elements from the schedules (doors, windows, cabinets, appliances, electrical, plumbing, etc.) 
when jumping to the plan.  

The active layer combination does NOT affect the listing of elements in the schedule. This is 
controlled by the schedule criteria, which may or may not include limitations for which layers are to be 
scanned for items to include in the schedule. 

A new SCHEDULE BASE SHEET View was created in the CONSTRUCTION DOCUMENT VIEWS > 
MISC. VIEWS (NON-CLONE) > MISC. PLAN VIEWS folder which uses the CONDOC | M-E-P 
SYSTEMS layer combination. This View was used as the basis for the creation of a new 
SCHEDULES (CLONE) folder. All of the schedules pre-placed as drawings on layouts were relinked 
(one by one) to these new versions of the Schedules, by right-clicking each one and selecting Link 
Drawing To… then selecting the appropriate newly created schedule. 

This was a tedious effort, since there are many schedules pre-placed on the layouts, and several 
different files (USA, USA Sample Project, INT, INT Sample Project) that were affected. However, it is 
anticipated that this change will significantly smooth out the workflow for developing schedules. 
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8) SAMPLE PROJECT FILE UPDATED 

In AMT16, the Sample Project file has been updated to use the ArchiCAD 16 Library. In addition, the 
Renovation Filters have been revised to match the new standards in AMT16, and the Views have 
been revised as needed. 

One small change from AMT15 Sample Project involves the new walls, which had been set to a 
special wall composite to show the core in a separate color for visual clarity. We did this in AC15 
because the Override style that changed the Fill for new elements actually obscured the wall 
composite linework. 

In AC16, it appears that Graphisoft has revised the way that the Renovation Override works, so that 
using an Override for the Fills of New elements does not remove the composite linework. For this 
reason, we have changed the wall composite for these New Construction walls back to a standard 
composite (the same as for the Existing walls) and are using the Override to color them a light blue or 
golden brown. 

NOTE: We plan to rework the Sample Project in the near future to be able to demonstrate Energy 
Analysis using ArchiCAD 16’s new built-in EcoDesigner module. This will be made available to all 
MasterTemplate 16 owners, along with a special training webinar teaching the basics of how to set up 
an energy analysis. The sessions will be presented as live webinars which will be recorded and made 
available in the member area of the MasterTemplate website. 
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SUGGESTED RENOVATION PROJECT WORKFLOW 

Unlike the standard Graphisoft ArchiCAD 15 template (in which all the Views in the View Map are set for 
the 01 Existing Plan Renovation Filter), in AMT16 we have set: 

• Views for Plans = 04 New Construction 
• Views for sections, elevations, interior elevations and 3D = 05 Planned Construction 

The main exceptions in AMT16 are: 

• Preliminary Design (MODEL / DESIGN VIEWS) = 06 Show All – this allows you to work on 
your preliminary design and see elements in ALL renovation categories. 

• Views in the RENOVATION folder, which use different Renovation Filters as appropriate: 
o Demo plans = 02 Demolition Plan 
o Existing plans = 01 Existing Plan 

The default status of elements in the Renovation palette is set for “Existing Status.” This means that all 
elements drawn will be considered “existing” rather than demo or new, unless you select them and 
change their category. 

This setup makes it possible to ignore the Renovation Filter categories while working on new projects, 
and gives the same results as in previous versions of ArchiCAD, easing the transition of existing users to 
ArchiCAD 16.  

It works simply and easily for projects that are new buildings, and simplifies the workflow for renovation 
and remodel projects.  

Here is our suggested process strategy for projects that involve demolition and/or new construction: 

1) Start a project using your office custom version of MasterTemplate as usual. Develop a model of 
the existing “as-built” building and site as desired. This can be somewhat conceptual or highly 
detailed; it will be possible to refine these existing elements and add more details as information 
becomes available at any point during the design process. 
 

2) When you are ready, select relevant elements and change their status to To Be Demolished or 
New Construction. You may also change the default status of elements in the Renovation palette 
to these categories so that (until you change it again) all newly created elements will be put in this 
category. 
 

3) The MODEL / DESIGN VIEWS show all elements regardless of Renovation Category. They will 
appear with color coding based on the active Override styles: red dashed lines for demo elements 
and blue pochéd fills for new elements.  
 
When the Preliminary Design view gets cluttered (after you have developed your model), switch 
to one of the other Model views to focus on particular parts of the model.  
 

4) When you are ready to annotate and start creating drawings for output, start using the 
Construction Document Views. The Plan views will show existing and new categories with 
Override color coding to make it easy to see the planned additions. Elevations and sections (and 
similar views) will show the final design without the Overrides. 
 

5) In certain projects, it may be useful to create Plan drawings that show all three categories of 
elements (existing, demo and new) on the same drawings. To do this, select the Clone folders for 
these plan drawings (e.g. Floor Plans, Ceiling Plans, etc.) and open the View Settings dialog, 
then switch the Renovation Filter to 06 Show All. The Override style will help make it clear which 
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elements are in which category. 
 
TIP: To simplify this process, you may select several Views or Clone Folders and click the 
Settings button, and change the Renovation Filter for multiple items at once. Be aware that this 
will not work if you select “normal” folders in the View Map; the Settings dialog will only be 
accessible if your selection only includes Views and Clone Folders. You may select one item and 
shift-click to select several in a row, or use CTRL-click or Command-click to add or take away 
individual items from the selection. 
 

6) To create and show Demolition Plans, use the appropriate Views in the RENOVATION folder of 
the View Map. Some of these plans are pre-placed onto the appropriate layouts. 
 

7) You may study, compare and present different phases of the building by manually changing the 
Renovation Filter in the Renovation palette, or by double-clicking on different Views in the View 
Map that are set to different Renovation Filters. You may even use alternate filtered views as 
Trace References. 
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MASTERTEMPLATE UPGRADE GUIDE 

Integrating MasterTemplate 16 with Your Existing Template  
There are two basic approaches for integrating the new version of the ArchiCAD MasterTemplate with 
customized templates created on earlier versions.  

1) Start over with the new ArchiCAD MasterTemplate 16, and customize it again. This approach is ideal 
for users who have not done much customization to MasterTemplate. 

2) Add the new components of AMT 16 to your existing template. This is best for experienced users who 
have done a lot of customization that they don't want to repeat. 

3) If you are upgrading from a version earlier than AMT 12.1 (e.g. AMT 12, 1.1 or 1.0), the choices are 
similar, however option 2 becomes more complex because many features were added to the file structure 
in AMT 12.1. 

TIP: For options 2 or 3, always save a copy of your existing (older) template before creating your new 
version. That way, you’ll have it available if for any reason you need to refer to it, or need to work in an 
earlier version of ArchiCAD. 
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1) UPGRADE GUIDE: How to Integrate Previous Customization into 
MasterTemplate 16 
If you only modified the standard MasterTemplate a small amount, then it may be best to start over with 
the new AMT 16 and rework it again to suit your needs. The simplest way to copy and reuse what you 
changed in AMT is to open up two sessions of ArchiCAD 16. 

In one session, open the standard MasterTemplate 16 TEMPLATE.tpl file. We suggest you immediately 
save this under a new name specific to your office, so that you don't overwrite the standard base version 
of the template in case you need to access it again. Choose the option to Save As an ArchiCAD Template 
(TPL format) so that the file will be usable as a Template file rather than as a PLN project file. We’ll call 
this your New MasterTemplate. 

In the other session of ArchiCAD 16, open your own custom template, the reworked version of an earlier 
MasterTemplate TEMPLATE.tpl file. We suggest you do a Save As for this template (which you have just 
opened up in ArchiCAD 16, perhaps for the first time). Use a new name so you won’t risk overwriting what 
you were using for a previous version of ArchiCAD. We’ll call this your Custom MasterTemplate. You can 
save this as either a TPL or PLN file, since we’ll only be using this as a source reference for copying 
information, then discarding it. 

Layout Masters 

You most likely have adjusted some or all of the Layout Masters. In your Custom MasterTemplate, go to 
the Layout Book and open up the Masters folder, then double-click on the first Master that you have 
customized to open it up. Activate the Arrow tool (if it's not already) and Select All (CTRL-A or CMD-A), 
then Copy to the Clipboard. Switch to your New MasterTemplate (the other session of ArchiCAD) and find 
the same Layout Master; Select All and Delete the contents; then Paste in the contents that you Copied 
from the Custom MasterTemplate file. 

Repeat this for each Layout Master that has been customized. If you deleted any Layout Masters in your 
Custom MasterTemplate in order to shorten your Master list, you may want to delete the corresponding 
ones in your New MasterTemplate. 

Schedules 

If you have added or customized Schedules in your Custom MasterTemplate, you can save these as XML 
files that can be imported into your New MasterTemplate. Double-click one of the entries in the Project 
Map > Schedules > Element list. Click the Scheme Settings… button and review the Schemes listed, and 
highlight one that is new or revised. Click the Export… button to save as an XML file; choose a folder to 
store it that you'll be able to locate easily, and give it an appropriate name. Repeat the Export action for 
each schedule in the list you want to transfer. 

Switch to your New MasterTemplate file, and open up one of the Schedules, then click the Scheme 
Settings… button. Click the Import… button and locate the folder in which you saved the XML files. 
Choose the first one and Import it. Repeat for each one in the folder. 

You may find you have redundant schedules: ones from AMT 16 with the same names as those you 
imported from your Custom MasterTemplate file. Review each pair of schedules that has duplicate names 
and figure out which one is "yours", and then use the Delete button to get rid of the other. 

On each Layout with a Schedule that refers to one that you have deleted and replaced, select the 
Schedule and right-click, then choose Link Drawing To. Choose the option at the top for "an internal View" 
then select the appropriate Schedule from the SCHEDULES (CLONE) folder. 
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Element Attributes (Materials, Fills, Composites / Wall Types, etc.) 

If there are any Attributes you have added, such as Materials, Fills, Composites / Wall Types, etc., you 
can use Attribute Manager to transfer them. 

In your New MasterTemplate, open the Options menu > Element Attributes > Attribute Manager. Then on 
the right side of the Attribute Manager dialog box, click the Open… button and browse for your Custom 
MasterTemplate. 

You will be able to select Materials, Fills, Wall Types, etc. from the right side file (your previous template), 
and Append them to the left side (the New MasterTemplate file you are customizing). Do not use the 
Overwrite button unless you know exactly what this means and feel that it is appropriate. 

Other Customization 

There are many ways to customize MasterTemplate. If you choose to follow this method (transferring 
your custom elements manually from your old Custom MasterTemplate to the New MasterTemplate file), 
you will have to go through your Custom MasterTemplate manually and copy each element or area that 
you've modified, then go back to the New MasterTemplate file and paste them in. 

Remember that you do not have to get this "perfect" in one session. You should retain the old Template 
file in case you need to access it later. You can always go back and get something you missed. 

When you are done (for now), be sure to save your file as a TPL (if you haven’t already). Then to test it, 
choose File menu > New and select Use a Template, then Browse… for New MasterTemplate TPL file. 
You should then get an untitled copy of the new template, and see all of your modifications in this untitled 
PLN file. The next time you create a new project file, this template TPL file will be the default in the 
popup, so you won’t have to browse to select it. 
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2) UPGRADE GUIDE: Integrating the New MasterTemplate 16 Features into 
Your Highly Customized MasterTemplate 12.1, 13, 14 or 15 File 
If you are an experienced user and have done a lot of customization to MasterTemplate, you may prefer 
to add to your existing template some or all of the new features of AMT 16. That way you can choose 
exactly what you wish to add or change. 

We suggest you review the new features outlined in these Release Notes carefully to understand what 
has been added or modified in AMT 16. Open up the standard AMT 16 Template and study it, and see 
how all the new things work. Then choose what you want to add to your own template, and use methods 
similar to the previous section to transfer what you wish. 

As with any project file, to move your Custom MasterTemplate forward, you may simply open it in 
ArchiCAD 16 and save it. This will now be an ArchiCAD 16 file. We suggest you save it with a new name 
or in a new folder, to avoid overwriting the earlier template file in case you need to do any work in your 
earlier version of ArchiCAD. 

Initially, this New MasterTemplate will reference the earlier ArchiCAD Library. You will need to use Library 
Manager to switch it to use the ArchiCAD 16 Library, plus (at least temporarily) the ArchiCAD Migration 
Libraries folder (which you’ll find in the AC16 folder). To get a “clean” template, you’ll need to switch out 
all parts in your template or Legend that refer to legacy libraries. In MasterTemplate, the references to 
library parts are primarily found in the Interactive Legends. 

Interactive Legends 

The Interactive Legends from earlier versions of AMT used the ArchiCAD Libraries current at the time. It 
is not generally a good idea to migrate templates forward with references to these legacy library parts, 
since it requires loading both the ArchiCAD 16 Library and Migration Libraries for every project. It’s better 
to update the Legend to use only the 16 Library plus specific custom parts you wish to use (which 
includes AMT-supplied parts as well as any of your own). 

To resolve this issue in your Custom MasterTemplate, you may: 

• Switch the Interactive Legends to use the new AMT 16 Interactive Legends based on the 
ArchiCAD 16 Library, or 

• Selectively bring in whatever parts of the new Legends you find useful. 

If you haven’t customized the Legends, simply relink the Hotlinked Module for the Legends in your 
template to use the AMT 16 version. Open the File menu > External Content > Hotlink Manager, then 
select AMT Legends (USA/INT) [15, 14, 13 or 12.1].pln from the list, click Relink, and browse for the new 
version of the file. You may need to switch the popup menu for file type to PLN file in order to see and 
select the AMT Legends USA 15.pln file. 

If you have customized the Legends, then you’ll need to copy and paste between your Custom Legend 
and the New Legend. Open up the AMT 16 LEGEND file and copy whichever parts you wish to use. 
Paste them into your own version of the Legends, and rearrange the Legend group positions as desired. 

For every part in your custom Legend file that is based on a legacy library, you should switch it to use the 
new library. Select it and in the Object (or Window or Door) Settings dialog, navigate to the corresponding 
part in the AC 16 Library, and click to switch to that part. Adjust the parameter values to get it the way you 
prefer. 

If you wish, you may use parameter transfer: hold down Option-Command or ALT-Control to get the 
syringe, and then click with the syringe to switch to the new part while transferring the values of all 
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corresponding parameters. Verify that your part looks correct in both the 2D and 3D previews, and then 
click OK. Repeat for every part referencing a legacy library. 

Once you have cleaned up all references to legacy libraries, return to Library Manager and remove the 
Migration Library. If the Library Loading report shows missing library parts and you see the special dots 
indicating missing parts on your floor plan, make a note of what you need to fix then reload the Migration 
Library and swap these legacy parts for current ones. Check it again, and repeat until you have a clean 
Legend that uses only the AC16 Library and has no missing library parts. 

TIP: In ArchiCAD 14 and later versions, library management has been improved, and you may 
accomplish migration of legacy parts (the task in the preceding paragraph) a little more simply 
than before. Instead of removing the Migration Library from the list to test if there are any 
remaining parts to migrate, you may highlight that library in the list then click on the little “i" 
[information] button below. You’ll get a new dialog box that shows which parts from that library 
are actively placed into the current file. Then you can use Find and Select to locate them, and 
replace them with equivalents from the ArchiCAD 16 Library (or you may embed them into the 
file). 

If you have an Office Favorites HLM module separate from the main Legend PLN file (as introduced in 
AMT 12.1), you will need to open that up and update it to use the ArchiCAD 16 Library instead of an 
earlier ArchiCAD Library. To open the Office Favorites file, you may select it in the File menu > External 
Content > Hotlink Manager, then click Open in Separate ArchiCAD. Follow the same process as above. If 
you wish, load the MasterTemplate 16 LIBRARY and embed its active parts into the file. 

If you have a Project Favorites HLM module, be sure to check it for legacy parts, then save a version in 
ArchiCAD 16 format. OPTIONAL: embed the library parts to make this file self-contained. 

For simplicity, put all your Hotlink Modules (the LEGEND as well as Office Favorites and Project 
Favorites) into the same folder as your Custom MasterTemplate for ArchiCAD 16, or into a subfolder of 
Linked Files. 

AMT Library 

The AMT library has been partially updated, and the parts that are actively in use are now embedded into 
the Legend PLN files. Library management will be simplest if you update your Hotlinked Module 
references in the File menu > External Content > Hotlink Manager to use the new Legend files. Then the 
AMT library parts will automatically be loaded directly from the Hotlink files. 

After updating the Hotlinks, for the USA version you may remove the reference to the old AMT Library, if 
you find it in the Library Manager, since it is not necessary.  

However, in the International version, for access to parts in the Detailer Legend, you will still need to load 
a linked library. In Library Manager, replace the earlier MasterTemplate Library reference and use the 
MasterTemplate 16 INT LIBRARY folder (located in the MasterTemplate Supplemental Files folder). After 
loading this library, you may embed this folder using Library Manager if you wish. 

Note for advanced users: Please see the technical note on library management at the end of this 
document for additional options. 
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3) UPGRADE GUIDE: Migrating from MasterTemplate 12 or earlier 

The Interactive Legend was substantially expanded in MasterTemplate 12.1. If you are upgrading from a 
version of MasterTemplate prior to AMT 12.1 (AMT 12, 1.1 or 1.0), it is simplest to use AMT 16 and 
repeat your customization (see section 1 above). 

However, if you did a lot of customization, you may choose to add selective parts of the new Legend 
system. Follow the general guidelines in section 2 above. However, since many enhancements were 
made to the file structure and the Legend layout in AMT 12.1, there are additional steps if you wish to 
take full advantage of all the innovations in the current MasterTemplate. 

The following notes are adapted from the AMT 12.1 Release Notes, and explain how to add in the new 
features introduced in AMT 12.1 to your version of the Legends and the template itself. 

Interactive Legend Expansion and Reconfiguration 

The Legend file itself was substantially expanded in AMT 12.1 with the addition of Quick Rooms (room 
arrangements that may either be studied or copied into your project to speed up preliminary design 
layouts) and Matrixes (groups of related objects). In AMT 12.1 and later, these new sections of the 
Legend are also referenced in saved 3D Views and 3D Documents. 

You may replace your own Interactive Legend file with the new one in AMT 16 (see notes in step 1 
above). Alternatively, you may copy and paste parts of the current Legend into your own version, or the 
reverse (adding in your components into the AMT 16 Legend). Be sure to rework your Legend to use the 
current Library (see step 2 above) as part of the update process. 

Legend Placement on Ground Floor 

If you want to use the concept of 3D Views and 3D Documents with your custom Legend, we suggest you 
move the Legend from the -1 Story to the Ground Floor. This will reduce the story-offset issue when using 
the eye-dropper on Legend elements in 3D (see the explanation in the section on 3D Views and 3D 
Documents in the AMT 12.1 Release Notes). You may either Cut the Legends from the -1 Story and then 
Paste them onto the Ground Floor, or delete them from the lower story and place them fresh on the 
Ground Floor. 

If you move the Legends from one story to another, you will need to recreate the Views of the Legend in 
the View Map that refer to the different sections of the Legend. This is because each View, once created, 
is linked to a specific source location (in this case, the floor plan story) which cannot be changed. Zoom in 
on each area of the Legend in its new location (story), and select the Save Current View option from the 
bottom of the View Map, then name the View appropriately. 

Legend Worksheet 

To use the new Worksheet access for the Legend, simply create a new Independent Worksheet. You 
don't have to draw anything in it. Open this worksheet, and then right-click on the View that refers to the 
Interactive Legend from the Plan, and choose Show as Trace Reference. Then in the Trace and 
Reference palette, choose the option to show the Reference in Original Color. 

In this worksheet, to quickly jump to specific areas of the referenced Legend, go to each area of the 
Legend then use the Zoom popup in the bottom left area of the worksheet window (the small triangle next 
to the percentage zoom value), then choose Save Current Zoom… and name it based on the Legend 
section name. Repeat for each zoom you wish to record - perhaps one overall zoom and as many as 20 
individual ones to point to each Legend area. 
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Create at least one View in the View Map to reference the Worksheet with the *PRELIMINARY DESIGN 
layer combination, and click the checkbox to Ignore Zoom when opening the view. This will bring up the 
Legend Worksheet to the last zoomed position. 

You may create multiple zoomed Views in the View Map for the Worksheet itself, as we did in AMT 12.1 
and 13, but this is not actually necessary. You may simply open the Worksheet from the View created in 
the previous paragraph, and use the Zoom popup to gain quick access when a different part of the 
Legend is needed. 

You may also open the Worksheet from the Project Map, or using Go To Last Worksheet from the context 
menu, Toolbar popup, or keyboard shortcut. This will bring up the Legend without altering the active 
Layer Combination (as would happen when you double-click a View). 

Legend Views - 3D 

To create the saved 3D Views of the Legend, activate one of the original (or recreated) Views that goes to 
the Legend on the Plan (not the worksheet version). Then draw a marquee around a section of the 
Legend, and choose Show Selection/Marquee in 3D. That should give you a 3D view of the Legend 
grouping you chose. Orbit around until you get an angle you like. Save as a new View in the View Map, 
and repeat for each Legend area that you wish to access. Make sure you use an appropriate Layer 
Combination when creating the 3D Views. 

You can create your own 3D Documents for these 3D Views of the Legend groupings as well. Once you 
have a 3D View that you wish to use, simply right-click in empty space and choose the Capture Window 
for 3D Document… command. Give it an appropriate name, and it will show up in the Project Map as a 
new 3D Document. You'll need to do one additional step: save the view of the 3D Document in the View 
Map (as usual, clicking the Save Current View button from the bottom of the View Map). 

Office Favorites and Project Favorites 

In the Template itself (as opposed to the Legend file), you may choose to add the Office Favorites and 
Project Favorites modules to the Legend area. These concepts were introduced in AMT 12.1, and may 
simplify your future customization of AMT by focusing it on files that are separate from the main Legend 
file. 

In AMT 12.1 and later, blank areas are included in the main Legend file, and these are used for 
placement of the Office Favorites and Project Favorites. All three are placed into the Template file itself. 
The idea is that: 

• The main Legend PLN is updated rarely (perhaps only when we release a new version of 
MasterTemplate). 

• The Office Favorites PLN may be periodically updated or expanded, and always show the latest 
version for all projects. 

• The Project Favorites PLN file (if used) is copied and separately maintained for each actual 
project file. 

Element Attributes 

When you paste in the new Legend either as a whole, or just the Quick Rooms and Parts Matrixes, the 
new Composite Wall Types, Materials, Fills and Layers are brought into the file automatically. You won't 
need to use Attribute Manager to import them. 

These should also become available in your Template file when the Legend HLM is updated in the Hotlink 
Manager. 
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The Layer Combinations for *PRELIMINARY DESIGN as well as the plan for SMALL SCALE drawings 
will not come in during this process. To add or rework layer combinations, you will need to create or 
adjust them manually. Other minor adjustments may be needed to reconcile the handful of new layers we 
added. 

This process of integration does not need to be done all in one session. You may bring in some of the 
new features of AMT 12.1, 13, 14, 15 and 16 into your existing template, then return later to pick up 
others that you missed or have decided to include. 	  

AMT Library 

The AMT library has been partially updated, and the parts that are actively in use are now embedded into 
the Legend PLN files. Library management will be simplest if you update your Hotlinked Module 
references in the File menu > External Content > Hotlink Manager to use the new Legend files. Then the 
AMT library parts will automatically be loaded directly from the Hotlink files. 

After updating the Hotlinks, for the USA version you may remove the reference to the old AMT Library, 
since it is not necessary.  

However, in the International version, for access to parts in the Detailer Legend, you will still need to load 
a linked library. In Library Manager, replace the earlier MasterTemplate Library reference and use the 
MasterTemplate 16 INT LIBRARY folder (located in the MasterTemplate Supplemental Files folder). After 
loading this library, you may embed this folder using Library Manager if you wish. 

Note for advanced users: Please see the technical note on library management at the end of this 
document for additional options. 
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4) UPGRADE GUIDE:  
Technical Note on Library Management for Advanced Users 

If you prefer to load the current MasterTemplate 16 library items as a Linked Library, you’ll find the 
following resources in the MasterTemplate Supplemental Files folder: 

• USA template: AMT16 USA LIBRARY 
• INT template: AMT16 INT LIBRARY 

If you have already relinked the Legend Hotlinked Modules to the new AMT 16 version files, you may get 
a report window from the Library Manager that there are Libraries with Duplicate Objects: 
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To clean this up, simply embed the active parts (as we do in AMT 16): click the Library Manager button, 
then highlight the MasterTemplate 16 (USA or INT) Library folder and click the icon button to “Embed 
Placed Objects of Selected Library”:  

  

After clicking, this dialog will come up, and you should check the box to embed textures and zone stamps: 

 

 


